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Editor’s 
Note

ถ้าจะถามถงึโปรแกรม CAD หรอื Computer Aided Design ที่ถูกสร้างมาเพื่อช่วยในการออกแบบด้วยคอมพวิเตอร์ 

ทางด้านงานเขยีนแบบ ไม่ว่าจะเป็นวศิวกรรม สถาปัตยกรรม หรอือื่นๆ ที่ต้องมแีบบแปลน ณ ปัจจบุนันี้ ทั่วโลกต่างก็

ยงัยกให้โปรแกรม AutoCAD เป็นโปรแกรมที่ครบเครื่องและเหมาะส�ำหรบัท�ำงานด้านนี้มากที่สดุ

ถึงแม้ว่าปัจจุบัน จะมีโปรแกรมเพื่อการท�ำงานด้านนี้ออกมามากมาย ทั้งเฉพาะทางส�ำหรบัประมาณราคา หรือ

เฉพาะทางส�ำหรบัท�ำภาพ 3 มติ ิแต่ที่สดุแล้ว แต่ละโปรแกรมกจ็ะเชื่อมโยงหรอืมพีื้นฐานมาจาก AutoCAD แทบทั้งสิ้น

จากที่กล่าวมาท�ำให้เราได้รู้ว่าการเรียนรู้โปรแกรม AutoCAD จนช�ำนาญแล้ว การจะเปลี่ยนหรือหัดใช้โปรแกรม

อื่นเพิ่มเตมินั้นจะท�ำได้ง่ายขึ้นมากถงึมากที่สดุ ท�ำให้การเรยีนรู้ครั้งนี้ จะเป็นประโยชน์กบัการท�ำงานไปยาวนาน และ

ไม่ต้องห่วงเมื่อต้องเปลี่ยนหรอืไปใช้โปรแกรมอื่นเพิ่มเตมิ

ส�ำหรับหนังสือเล่มนี้ นอกจากเนื้อหาที่ครบถ้วน และการสอนแบบจับมือท�ำตามกันไปทีละสเต็ปแล้ว ผู้เขียนยัง 

	 ได้เพิ่มฟังก์ชนัการท�ำงานที่นอกเหนอืจากขั้นพื้นฐานเข้าไป จนท�ำให้มั่นใจได้ว่า “ครบและสมบรูณ์” สามารถ 

		  เรียนรู้โปรแกรมได้จนจบในเล่มเดียว หากค่อยๆ เรียนรู้ไปทีละบทจนครบ มั่นใจได้เลยว่าเราจะ 

			   เป็นคนหนึ่งที่ใช้ AutoCAD ได้เป็นและคล่องแคล่วตามที่ต้องการอย่างแน่นอน

				    ขอให้สนกุกบัการเรียนรู้โปรแกรมครบั

ปิยะบุตร สุทธิดารา

มกราคม 2565
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Writer’s 
Note

แม้วนัเวลาจะเปลี่ยนแปลงไปเรว็ขนาดไหน จะมเีทคโนโลยอีะไรใหม่ๆ เพิ่มขึ้นมามากมาย การสื่อสารด้วยภาพกย็งั

เป็นสิ่งที่ท�ำให้ผู้คนเข้าใจร่วมกนัได้ดีที่สดุ ยิ่งถ้าเป็นการสร้างสรรค์งานต่างๆ เพื่อที่จะให้ทกุคนเข้าใจได้ตรงกนั “แบบ” 

จงึเป็นสิ่งที่ท�ำให้เรามองภาพรวมทั้งหมดออกว่า สิ่งที่พูดถงึกนัอยู่นั้นมรีูปร่างหน้าตาเป็นอย่างไร ไม่ว่าจะเป็นแบบของ

เสื้อผ้า ทรงผม เครื่องประดบั เฟอร์นเิจอร์ รถยนต์ ร้านค้า อาคารที่อยู่อาศยั หรอืแม้กระทั่งแบบของสื่อออนไลน์ใน

แพลตฟอร์มต่างๆ กต็้องมแีบบเพื่อใช้ในการท�ำให้สิ่งต่างๆ นั้นออกมาได้ตามที่ต้องการ การเขยีนแบบจงึเป็นสิ่งส�ำคญั

ที่จะช่วยท�ำให้เรานั้นเข้าใจตรงกนั อาจจะเขยีนด้วยมอือย่างง่ายๆ กไ็ด้ถ้ารายละเอียดไม่มากนกั หรอืจะใช้โปรแกรมใน

การเขยีนแบบกไ็ด้ ขึ้นอยูก่บัรปูแบบของงานในแต่ละด้าน ส�ำหรบัการเขยีนแบบในงานด้านอตุสาหกรรมทั้งเครื่องจกัรกล  

ไฟฟ้า อิเล็กทรอนิกส์ ไปจนถึงงานด้านสถาปัตย์ โยธา ก่อสร้าง คงจะต้องยกให้กับโปรแกรม AutoCAD ซึ่งเป็น

โปรแกรมเขียนแบบแปลนที่ใช้งานง่ายและนิยมกันอย่างแพร่หลาย จึงเหมาะกับผู้เริ่มต้นที่คิดจะหัดเขียนแบบ 2 มิติ

ด้วยคอมพวิเตอร์ อกีทั้งยงัสามารถเขยีนแบบรูปทรง 3 มติไิด้อกีด้วย ซึ่งหวงัว่าหนงัสอืเล่มนี้จะช่วยให้ผู้อ่าน		

ได้เรยีนรู้และเข้าใจการเขยีนแบบแปลนด้วยคอมพิวเตอร์จากโปรแกรม AutoCAD ได้ดยีิ่งขึ้น

อิศเรศ ภาชนะกาญจน์

มกราคม 2565
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ส�ำหรับบทแรกนีจ้ะกล่าวถงึการเขยีนแบบ และภาพรวม 

ของโปรแกรม AutoCAD ทั้งส่วนประกอบต่างๆ ของ

โปรแกรม ค�ำสั่งเบื้องต้นที่ใช้ได้ทั้งการเขียนแบบ 2D และ 

3D รวมไปถึงการลองเขียนแบบจากช้ินงาน 2D จนเป็น 

ชิ้นงาน 3D อีกด้วย
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การเขยีนแบบ และ AutoCAD
ก่อนที่จะไปเรยีนรูก้ารใช้งานของโปรแกรม AutoCAD เรามาท�ำความเข้าใจเกี่ยวกบัการเขยีนแบบ และการเขยีนแบบ 

ด้วย CAD (Computer Aided Drafting/Computer Aided Design) กนัก่อน

ท�ำไมต้องเขยีนแบบ
การเขยีนแบบเป็นการเขยีนที่แสดรปูร่างลกัษณะ และขนาดทกุๆ ส่วนของสิ่งของต่างๆ เพื่อใช้ในการสื่อสาร

ท�ำความเข้าใจให้ไปในทศิทางเดยีวกนั โดยการเขยีนแบบจะใช้ในงานด้านสถาปัตยกรรม เช่น การเขยีนแบบรปูทรง 

สดัส่วน โครงสร้างอาคาร หรอืงานโยธา และงานด้านอตุสาหกรรม เช่น การเขยีนแบบไฟฟ้า อเิลก็ทรอนกิส์ เครื่องกล 

หรอืเครื่องยนต์ ดงันั้น การเขยีนแบบจงึเป็นสิ่งจ�ำเป็นที่ใช้ในการท�ำงานด้านสถาปัตยกรรม และด้านอตุสาหกรรม 

เพื่อสร้างสรรค์ผลงานต่างๆ ให้ออกมาตรงตามที่ได้วางแผนเอาไว้

เขยีนแบบด้วย CAD
ในสมยัก่อนการเขยีนแบบจะเป็นการเขยีนด้วยดนิสอลงในกระดาษ หรอืหมกึลงในกระดาษไข แล้วน�ำไปท�ำ

พิมพ์เขียว แต่ในยุคสมัยนี้คอมพิวเตอร์ได้เข้ามามีบทบาทอย่างมากในทุกๆ ด้าน รวมถึงงานด้านสถาปัตยกรรม 

และงานด้านอตุสาหกรรม ทั้งการท�ำแบบจ�ำลองเสมอืนจรงิผ่านทางคอมพวิเตอร์ก่อนที่ฝ่ายก่อสร้าง หรอืฝ่ายผลติ

จะเริ่มปฏบิตังิานจรงิ ท�ำให้การท�ำงานนั้นสะดวกรวดเรว็ยิ่งขึ้น อกีทั้งมคีวามถกูต้องแม่นย�ำและความสวยงาม เรา

จงึนยิมเขยีนแบบด้วยคอมพวิเตอร์ หรอืที่เรยีกว่า CAD – Computer Aided Drafting หรอื Computer Aided Design 

ซึ่งใช้ได้ทั้ง 2 ความหมายไม่ว่าจะเป็นการเขยีนแบบหรอืออกแบบ โดยการเขยีนแบบด้วย CAD นั้น จะมโีปรแกรม

ให้เลือกใช้อยู่หลายโปรแกรม แต่ที่นิยมใช้กันอย่างแพร่หลายคงจะหนีไปไม่พ้น AutoCAD ซึ่งเวอร์ชันล่าสุดก็คือ 

AutoCAD 2022 ส�ำหรบัการเขยีนแบบด้วย AutoCAD นั้นจะมทีั้งแบบ 2 มติ ิ (2D) และแบบ 3 มติ ิ (3D) ซึ่งการ 

ใช้งานและผลลพัธ์ที่ได้จะแตกต่างกนั 

ภาพตัวอย่างงานเขียนแบบในด้านสถาปัตยกรรม และด้านอุตสาหกรรม
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การเขยีนแบบ 2D ด้วย AutoCAD
การเขยีนแบบ 2 มติ ิหรอืที่เรยีกว่า 2D นั้น เป็นการเขยีนแบบแปลน หรอืภาพตดั ที่อยูใ่นระนาบแกน X และ

แกน Y ใช้ในการสื่อสารเพื่อก่อสร้างอาคาร หรอืผลติชิ้นงาน ให้ออกมาตรงตามแบบที่ได้วางแผนและออกแบบไว้ ซึ่ง

ในโปรแกรม AutoCAD จะใช้เป็น Workspace แบบ Drafting & Annotation ในการเขยีนแบบ 2 มติ ิ(2D)

แบบแปลน หรือภาพตัดที่ใช้โปรแกรม AutoCAD ในการเขียนแบบ 2 มิติ 

การเขยีนแบบ 3D ด้วย AutoCAD
การเขยีนแบบ 3 มติ ิ หรอืที่เรยีกว่า 3D นั้น เป็นการขึ้นรปูทรง หรอืสร้างชิ้นงานรปูแบบของ 3 มติ ิ ที่อยูใ่น

ระนาบแกน X, แกน Y และแกน Z ถ้าหากจะเปรียบเทียบจุดประสงค์ของการเขียนแบบและการใช้งานระหว่าง 

2D และ 3D จะเห็นได้ว่าไม่ได้แตกต่างกันมากนัก อย่างไรก็ดีประโยชน์ที่ได้จากการสร้างชิ้นงาน 3D จะท�ำให้

วศิวกรสามารถศกึษาองค์ประกอบต่างๆ ได้ง่ายยิ่งขึ้น เช่น วศิวกรสามารถจ�ำลองการประกอบชิ้นส่วนแต่ละชิ้นเพื่อ 

ตรวจสอบความผดิพลาด ก่อนที่จะมกีารสร้างชิ้นงานจรงิได้ หรอืการสร้างแบบจ�ำลองโรงงานขึ้นมาเป็นแบบ 3D เพื่อ

ใช้ในการตรวจสอบความเหมาะสมทางด้านการซ่อมบ�ำรงุ ความปลอดภยั และในด้านอื่นๆ ซึ่งในโปรแกรม AutoCAD 

จะใช้เป็น Workspace แบบ 3D Modeling ในการเขยีนแบบ 3 มติ ิ(3D)

การขึ้นรูปทรงชิ้นงาน 3D ที่ใช้โปรแกรม AutoCAD ในการเขียนแบบ 3 มิติ

Book 1.indb   3 1/13/22   11:33 AM



Professional Guide AutoCAD 2022

4

มีอะไรใหม่ใน AutoCAD 2022 (New Feature)
ส�ำหรบั AutoCAD 2022 ในเวอร์ชนัใหม่นี้ มอีะไรใหม่เพิ่มขึ้นมาอยู่หลายอย่างด้วยกนั เราจงึได้เลอืกส่วนที่เหน็

ได้เด่นชัดมา 6 อย่าง ที่จะช่วยในการท�ำงานให้เขยีนแบบได้สะดวกรวดเร็วและมปีระสทิธภิาพยิ่งขึ้น

หน้าแรกรูปแบบใหม ่(Start Tab Redesign)
Start Tab เป็นหน้าแรกของการเข้าสูโ่ปรแกรม ที่ใช้ในการเลอืกการเริ่มต้นในการท�ำงานของเราว่าต้องการที่จะ

ใช้งานแบบไหน จะสร้างไฟล์งานใหม่ (New), เปิดไฟล์งานเดมิ (Open) หรอืใช้งานไฟล์ล่าสดุ (Recent) ซึ่งเวอร์ชนั 

2022 นี้จะถูกออกแบบใหม่เพื่อให้ใช้งานได้ง่ายขึ้น แต่กไ็ม่ได้เปลี่ยนไปจากเดมิมากนกั

Start Tab รูปแบบใหม่ ท�ำให้ใช้งานได้ง่ายยิ่งขึ้น

นับจ�ำนวน Block หรือรูปทรงเรขาคณิต (Count)
การนบัจ�ำนวน Block หรอืรูปทรงเรขาคณติจะง่ายและแม่นย�ำยิ่งขึ้นด้วยค�ำสั่ง Count ที่จะนบัจ�ำนวนให้แบบ

อตัโนมตั ิโดยจะแสดงและจดัการบลอ็กที่นบัใน Drawing ปัจจบุนัไว้ที่ Count Palette

คลิกค�ำสั่ง Count จะแสดงจ�ำนวน Block หรือรูปทรงเรขาคณิตต่างๆ ไว้ที่ Count Palette
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ดึงแท็บหน้าต่างการท�ำงานออกมาได้ (Floating Window)
ส�ำหรบัเวอร์ชนั 2022 เราสามารถที่จะดงึแทบ็ (Tab) หน้าต่างการท�ำงาน (Drawing) ออกมาจากหน้าจอการ

ท�ำงานได้แบบอสิระ ท�ำให้ง่ายและสะดวกในการท�ำงานกบั Drawing หลายๆ หน้าต่าง ทั้งการดูและแก้ไขงานข้าม

หน้าต่างกนัไปมาอย่างอสิระ

แดรกเมาส์ดึงแท็บ (Tab) หน้าต่างการท�ำงาน (Drawing) ได้อย่างอิสระ ช่วยให้สะดวกในการท�ำงาน

ตรวจสอบและเพิ่มข้อเสนอแนะ (Trace)
เราสามารถที่จะตรวจสอบและเพิ่มข้อเสนอแนะได้โดยตรงไปยงัไฟล์ DWG โดยที่ไม่ต้องแก้ไขภาพวาดที่มอียู่

ด้วยค�ำสั่ง Trace ซึ่งจะช่วยให้ท�ำงานกบัเพื่อนร่วมทมีได้อย่างรวดเรว็และปลอดภยั เพราะการตรวจสอบและเพิ่ม

ข้อเสนอแนะโดยตรงไปยงัไฟล์ DWG จะไม่ถูกแก้ไขหรอืส่งผลอะไรกบัไฟล์ต้นฉบบั

Trace จะช่วยให้การตรวจสอบและเพิ่มข้อเสนอแนะปลอดภัย เพราะจะไม่ส่งผลกับไฟล์ DWG
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ส่งส�ำเนาภาพวาด (Share)
เราสามารถที่จะส่งส�ำเนาภาพวาด (Drawing) ไปให้เพื่อนร่วมทมีเพื่อเข้าถงึได้ทกุที่ด้วยค�ำสั่ง Share Drawing 

ซึ่งเราสามารถก�ำหนดการเข้าถงึส�ำเนาได้ว่าต้องการแค่ให้ดูได้เท่านั้น หรอืสามารถแก้ไขส�ำเนานั้นได้ ท�ำให้การส่ง

ส�ำเนาภาพวาดท�ำได้ง่ายและปลอดภยัยิ่งขึ้น

ส่งส�ำเนาภาพวาดได้ง่ายและปลอดภัยด้วย Share Drawing

สร้างไฟล ์PDF ได้เร็วยิ่งขึ้น (Push to Autodesk Docs)
เพยีงแค่คลกิค�ำสั่ง Push to Autodesk Docs เรากส็ามารถที่จะเลอืกแผ่นงานวาด (Layout) เพื่ออพัโหลดเป็น

ไฟล์ PDF ไปยัง Autodesk Docs ได้อย่างง่ายดาย

สร้างไฟล์ PDF ได้อย่างง่ายดายด้วย Push to Autodesk Docs
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เข้าสูโ่ปรแกรม AutoCAD 2022
การเข้าสูโ่ปรแกรม AutoCAD 2022 นั้นสามารถท�ำได้ 2 วธิคีอื ดบัเบลิคลกิที่ไอคอน AutoCAD 2022 หรอืคลกิ

ปุม่ Start แล้วคลกิเลอืก AutoCAD 2022 > AutoCAD 2022 เมื่อเข้ามาหน้าโปรแกรมจะเจอกบั Start Tab ซึ่งจะแบ่ง

การใช้งานออกเป็น 3 ส่วนหลกัๆ ด้วยกนั

คลิกปุ่ม Start > AutoCAD 2022 > AutoCAD 2022 หรือดับเบิลคลิกที่ไอคอน AutoCAD 2022

A 	 Open/New จะเป็นส่วนที่ใช้เลอืกการเริ่มต้นในการใช้งานว่า เราต้องการที่จะใช้งานแบบไหน เริ่มเขยีนงานใหม่ 

เลอืกแบบงานที่มมีาให้ (Templates) หรอืจะเปิดไฟล์งานที่มอียูแ่ล้ว ซึ่งเราสามารถคลกิเลอืกตรงส่วนนี้ได้

B 	 Recent ไฟล์ล่าสดุที่เราได้เคยเปิดใช้งานจะแสดงขึ้นมาตรงส่วนนี้ หากต้องการจะเข้าไปใช้งานเดมิที่เคยท�ำไว้ 

กส็ามารถคลกิเลอืกไฟล์นั้นที่แสดงไว้ตรงส่วนนี้ได้ทนัที

C 	 Announcements เป็นส่วนของประกาศ (Announcements) ที่จะแจ้งข้อมลูข่าวสารต่างๆ และการเชื่อมต่อ 

(Connect), การเข้าใช้งานแบบออนไลน์ (Sign In) หรอืส่งข้อเสนอแนะต่างๆ (Feedback)
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Workspace แบบ 2D Drafting & Annotation จะใช้ในการเขยีนแบบ 2D ส่วนการขึ้นรปูทรง 3D จะมรีปูแบบการท�ำงานอยู่ 
2 แบบด้วยกนัคอื 3D Basics กบั 3D Modeling ซึ่งเราจะใช้ Workspace แบบ 3D Modeling ใน Part ของการท�ำงาน 3D

NOTE การเปลี่ยนรูปแบบการท�ำงาน (Workspace)

เมื่อคลกิที่ Start Drawing จะเข้าสู ่Workspace ให้เราคลกิปุม่ Customize Quick Access Toolbar (ปุม่ลกูศรชี้ลง) 

แล้วเลอืก Workspace และ Show Menu Bar เพื่อให้แสดงรปูแบบการท�ำงาน (Workspace) ที่ Quick Access Toolbar 

และแถบเมนูค�ำสั่ง (Menu Bar) โดย Workspace ในตอนนี้จะเป็นรปูแบบ 2D Drafting & Annotation ซึ่งเป็น Workspace 

ที่ใช้ในการเขยีนแบบ 2D หากต้องการขึ้นรปูทรง 3D ให้เราเปลี่ยน Workspace เป็นรปูแบบ 3D Modeling

คลกิปุม่ Customize Quick Access Toolbar แล้วเลอืก Workspace และ Show Menu Bar เพือ่ให้แสดง Workspace และ Menu Bar

Menu Bar และ Workspace จะถูกแสดงขึ้นมา สามารถเปลี่ยนรูปแบบการท�ำงานได้จากตรงส่วนนี้
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หน้าตาและส่วนประกอบต่างๆ ของ AutoCAD
ส่วนประกอบหลกัๆ ของพื้นที่การท�ำงาน (Workspace) ทั้งรปูแบบ 2D Drafting & Annotation และ 3D Modeling 

นั้นจะเหมอืนกนั แต่จะต่างกนัตรงที่ค�ำสั่งที่ใช้ในการเขยีนแบบหรอืขึ้นรูปทรงเท่านั้น ดงันั้น เรามาดูส่วนประกอบ

หลกัๆ ว่าแต่ละส่วนคอือะไร และมรีายละเอยีดอะไรที่น่าสนใจบ้าง

A 	 Application Menu เป็นที่รวบรวมค�ำสั่งพื้นฐาน

ทั้งหมด เช่น ค�ำสั่ง New, Open, Save หรอื Plot

B 	 Quick Access Toolbar เป็นที่รวบรวมค�ำสั่งหรอื

เครื่องมอืที่ต้องการใช้งานแบบเร่งด่วน 

C 	 Menu Bar เป็นที่รวบรวมของกลุ่มค�ำสั่งทั้งหมด 

โดยจะแบ่งแยกกลุม่ค�ำสั่งออกเป็นเมนตู่างๆ 

D 	 Ribbon คล้ายกบั Menu Bar แต่กลุม่ค�ำสั่งจะมี 

รปูแบบเป็นไอคอน เพื่อสะดวกในการเรยีกใช้ค�ำสั่ง

E 	 File Tabs เป็นแทบ็แสดงไฟล์งานที่เราได้ใช้งานอยู่

หรอืไฟล์งานเปิดขึ้นมาใช้งาน 

F 	 Drawing Window เป็นพื้นที่การท�ำงานที่เรา 

จะใช้ในการเขยีนแบบ 2D หรอืขึ้นรปูทรง 3D 

G 	 Cross Hair เป็นเครื่องหมายที่ใช้แสดงต�ำแหน่งบน

พื้นที่การท�ำงาน ซึ่งจะเคลื่อนที่ตามการเลื่อนของ

เมาส์

H 	 Dynamic Input เป็นส่วนที่รบัค�ำสั่งบนพื้นที่การ

ท�ำงานด้วยการพมิพ์ ก�ำหนดค่า หรอืเลอืกค�ำสั่งย่อย

I 	 View Cube เป็นส่วนที่ใช้ในการเลือกเปลี่ยน 

มุมมองของภาพในรูปแบบด้านต่างๆ ของชิ้นงาน

รปูทรง 3D

J 	 Navigation Bar เป็นกลุม่ค�ำสั่งที่ใช้ในการควบคมุ

มมุมองของภาพ ทั้งการย่อขยาย เลื่อน หรอืหมนุดู

ชิ้นงาน

K 	 UCS Icon เป็นไอคอนแสดงระบบพกิดัในแกนต่างๆ 

ทั้งแกน X, แกน Y และแกน Z

L 	 Command Line เป็นส่วนที่ใช้รับค�ำสั่งผ่าน

ทางการพมิพ์ด้วย Keyboard หรอืใช้เลอืกค�ำสั่งย่อย

M 	 Status Bar เป็นส่วนที่แสดงสถานะในการท�ำงาน

ของค�ำสั่งต่างๆ ที่ได้เลอืกมาช่วยในการเขยีนแบบ 
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Application Menu
เป็นเมนทูี่รวบรวมกลุม่ค�ำสั่งพื้นฐานทั้งหมด ทั้งค�ำสั่ง New, Open หรอื 

Save ด้วยการคลกิปุม่ Application Menu แล้วเลอืกค�ำสั่งที่ต้องการใช้งาน

Quick Access Toolbar
เป็นส่วนที่รวบรวมค�ำสั่งพื้นฐานที่ใช้บ่อยๆ ที่ต้องการใช้งานแบบเร่งด่วน 

ซึ่งเราสามารถเลือกค�ำสั่งมาเก็บไว้ในส่วนนี้ โดยคลิกปุ่มลูกศร Customize 

Quick Access Toolbar แล้วเลอืกค�ำสั่งที่ต้องการ

Menu Bar
เป็นแถบเมนทูี่รวมค�ำสั่งต่างๆ ทั้งหมด ซึ่งจะแบ่งแยกกลุม่ค�ำสั่งออกตามหมวดหมู่ เช่น เมน ูFile จะเป็นค�ำสั่ง

ที่เกี่ยวข้องกบัไฟล์งาน หรอืเมน ูDraw เป็นค�ำสั่งที่เกี่ยวข้องกบัการเขยีนเส้นหรอืรปูทรง 
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Ribbon
เป็นที่รวบรวมของค�ำสั่งและเครื่องมอืคล้ายกบั Menu Bar ซึ่งจะแบ่ง

ออกเป็นกลุ่มๆ เช่นกัน แต่จะมีรูปแบบเป็นไอคอน ท�ำให้สะดวกในการ

เรยีกใช้ค�ำสั่ง ถ้าวางเมาส์ที่ค�ำสั่งไหน จะมคี�ำอธบิายการใช้งานของค�ำสั่ง

นั้นแสดงขึ้นมาด้วย

File Tabs
แท็บแสดงรายชื่อของไฟล์ที่ท�ำงานหรือเปิดขึ้นมาใช้งาน ซึ่งจะแบ่งไฟล์ออกเป็นแท็บ หากต้องการท�ำงานที่ 

ไฟล์ไหนให้คลิกเลือกที่แท็บไฟล์นั้น พื้นที่การท�ำงานก็จะเปลี่ยนไป นอกจากนั้นยังสามารถสร้างไฟล์ขึ้นมาใหม่ 

(New) ด้วยการคลกิปุ่มเครื่องหมายบวก หรอืเปิดไฟล์ (Open) ด้วยการคลกิแทบ็ Start

Drawing Window
เป็นพื้นที่การท�ำงานที่เราจะใช้ในการเขยีนแบบ 2D หรอืขึ้นรปูทรง 3D ซึ่งสามารถก�ำหนดให้มเีส้นตาราง (Grid) 

หรอืไม่มกีไ็ด้ โดยการกดปุ่ม F7  เพื่อเปิดปิดเส้นตาราง (Grid) 
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Cross Hair
เป็นเครื่องหมายที่ใช้แสดงต�ำแหน่งบนพื้นที่การท�ำงาน ในรปูแบบของเส้นกากบาทที่จะเคลื่อนที่ตามการเลื่อน

ของเมาส์ ซึ่งเราสามารถปรบัขนาดของ Cross Hair ได้

Dynamic Input
เป็นส่วนที่รบัค�ำสั่งบนพื้นที่การท�ำงานด้วยการพมิพ์ ก�ำหนดค่าตวัเลข หรือเลอืกค�ำสั่งย่อยต่างๆ 

View Cube
เป็นส่วนที่ใช้ในการเลอืกเปลี่ยนมมุมองของภาพในรูปแบบด้านต่างๆ ของชิ้นงานวตัถ ุ3 มติ ิซึ่งมดี้านให้เลอืก

อยู่ 26 ด้านด้วยกนั โดยการคลกิเลอืกด้านที่ต้องการ มมุมองของภาพกจ็ะเปลี่ยนไปตามด้านที่เลอืก
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Navigation Bar
เป็นกลุ่มเครื่องมอืที่ใช้ในการควบคมุมมุมอง ทั้งการย่อขยาย เลื่อน หรอืหมนุดูภาพทั้งชิ้นงาน 2D และ 3D

UCS Icon
เป็นไอคอนแสดงระบบพกิดัในแกนต่างๆ ทั้งแกน X, แกน Y และแกน Z โดยถ้าเป็นการเขยีนแบบ 2D จะมี

แค่แกน X และแกน Y ส่วนถ้าเป็นการขึ้นรูปทรง 3D จะมแีกน Z เพิ่มขึ้นมาด้วย

Command Line
เป็นส่วนที่ใช้รับค�ำสั่งผ่านทางการพิมพ์ด้วย Keyboard หรือใช้เลือกค�ำสั่งย่อย โดยการพิมพ์ค�ำสั่งที่ต้องการ 

ก�ำหนดค่าตวัเลข หรอืคลกิเลอืกค�ำสั่งย่อยของค�ำสั่งหลกั รวมถงึแสดงค�ำสั่งที่เราได้ใช้ไปแล้วอกีด้วย
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Status Bar
เป็นส่วนที่แสดงสถานะการท�ำงานของค�ำสั่งต่างๆ ที่ช่วยในการเขียนแบบ ทั้งการเปลี่ยนพื้นที่การท�ำงาน 

Workspace สถานะของการใช้งาน Grid, Snap, Polar Tracking หรอื Object Snap โดยถ้าเปิดใช้ค�ำสั่งไหนจะเหน็เป็นแสง

สนี�้ำเงนิ ซึ่งสามารถเปิดปิดได้ด้วยการคลกิไอคอนค�ำสั่งที่ Status Bar หรอืใช้ Function Keys นอกจากนั้นเราสามารถ

เพิ่มหรอืลดค�ำสั่งที่อยู่ใน Status Bar ได้ด้วยการคลกิปุ่ม  (Customization) แล้วเลอืกค�ำสั่งต่างๆ ตามที่ต้องการ 

คลิกปุ่ม Customization เพื่อเลือกค�ำสั่งมาใช้ใน Status Bar

คลิกปุ่ม Command History เพื่อแสดงการใช้ค�ำสั่งย้อนหลัง
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ในบทต่อๆ ไปที่ชื่อค�ำสั่งต่างๆ เราได้บอกการเรยีกใช้ค�ำสั่งให้ไว้ทั้ง 3 วธิคีอื การคลกิที่ Ribbon, คลกิเลอืกเมนู และการ
พมิพ์ชื่อค�ำสั่ง เช่น Polyline | Draw > Polyline | PL (PLINE) หมายถงึ เราสามารถเลอืกค�ำสั่ง Polyline ได้ทั้งการคลกิ 
Polyline ที่ Ribbon, คลกิเมนู Draw > Polyline หรอืพมิพ์ค�ำว่า pl ที่คยี์บอร์ด Dynamic Input จะแสดงค�ำสั่ง PL (PLINE) 
ขึ้นมาให้เลอืกใช้ได้เช่นกนั ขึ้นอยู่กบัว่าเราถนดักบัการเรยีกใช้ค�ำสั่งในรูปแบบไหน

NOTE เลือกการใช้ค�ำสั่งได้ทั้ง 3 วิธี (Ribbon | Menu Bar | Command Line & Dynamic Input) 

การเรียกใช้ค�ำสั่งในแบบต่างๆ
การเข้าสูค่�ำสั่งหรอืเรยีกใช้ค�ำสั่งต่างๆ เพื่อการใช้งาน เราสามารถเรยีกค�ำสั่งได้ 3 วธิด้ีวยกนัคอื การคลกิไอคอน

ค�ำสั่งที่ Ribbon, การคลกิเลอืกค�ำสั่งที่ Menu Bar และการพมิพ์ค�ำสั่งที่ Command Line หรอื Dynamic Input ทั้งนี้

ขึ้นอยู่กบัความถนดัและชนดิของค�ำสั่งที่เราจะเลอืกใช้

คลิกไอคอนค�ำสั่งจาก Ribbon
การใช้ค�ำสั่งที่ Ribbon เป็นการเรยีกใช้ค�ำสั่งที่ง่ายและสะดวก เนื่องจากเป็นไอคอนที่มรีูปสญัลกัษณ์ของค�ำสั่ง 

แสดงให้ หากวางเมาส์ค้างไว้ที่ค�ำสั่งไหน กจ็ะมคี�ำอธบิายและรปูภาพแสดงวธิกีารใช้งานของค�ำสั่งนั้นขึ้นมาให้เหน็

อกีด้วย เหมาะกบัการใช้ค�ำสั่งเขยีนเส้นหรอืรูปทรงภาพ และดดัแปลงแก้ไขชิ้นงานทั่วไป เช่น Line, Circle, Copy 

หรอื Move เพยีงแค่คลกิไอคอนค�ำสั่งนั้น แล้วคลกิใช้ค�ำสั่งที่พื้นที่การท�ำงานได้เลย (Drawing Window) ซึ่งวธิกีารใช้ 

ค�ำสั่งจะต่างกนัออกไปตามค�ำสั่งที่เราเลอืก โดยจะมขีั้นตอนบอกไว้ในส่วนของ Command Line หรอื Dynamic Input
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คลิกเลือกค�ำสั่งจาก Menu Bar
การเข้าสูค่�ำสั่งด้วยการใช้ Menu Bar เป็น Menu Browser ที่จะมคี�ำสั่งที่แยกออกเป็นหมวดหมู ่ทั้งเมนูหลกัและ

เมนูย่อย เหมาะสมกบัการเข้าสูค่�ำสั่งที่ใช้ในการก�ำหนดค่า (Dialog Box) หรอืค�ำสั่งที่ไม่มอียูใ่น Ribbon เราสามารถ 

เรยีกใช้ค�ำสั่งได้จาก Menu Bar โดยการคลกิเมนคู�ำสั่ง > คลกิเลอืกค�ำสั่งหลกั > คลกิเลอืกค�ำสั่งย่อย (หากมคี�ำสั่งย่อย) 

คลิกเมนู Draw > Circle > Center, Diameter เพื่อเลือกใช้ค�ำสั่ง Circle แบบ Center, Diameter 

คลิกเมนู Tools > Options เพื่อเข้าไปก�ำหนดค่าต่างๆ ที่หน้าต่าง Options 
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พิมพ์ค�ำสั่งจาก Command Line หรือ Dynamic Input 
การเรยีกใช้ค�ำสั่งที่ Command Line หรอื Dynamic Input เป็นการเรยีกค�ำสั่งด้วยการพมิพ์ชื่อค�ำสั่ง เราสามารถ

พมิพ์ที่ Command Line หรอืพมิพ์ในพื้นที่การท�ำงาน ซึ่งจะเป็นการพมิพ์ใน Dynamic Input กไ็ด้เช่นกนั แต่เราต้อง

จดจ�ำชื่อค�ำสั่งให้ได้ หากใช้งานบ่อยๆ จนจ�ำชื่อค�ำสั่งได้ การเรียกใช้ค�ำสั่งด้วยวิธีนี้จะรวดเร็วเช่นกัน เพราะบาง 

ค�ำสั่งจะมชีื่อย่อ เช่น ค�ำสั่ง Polyline เพยีงแค่พมิพ์ PL กส็ามารถเข้าถงึค�ำสั่ง Polyline ได้แล้ว 

นอกจากการพมิพ์ค�ำสั่งที่ Command Line หรอื Dynamic Input แล้ว เรายงักดปุ่มบนคยี์บอร์ด เพื่อเข้าสู่ค�ำสั่งต่างๆ ได้
อกีด้วย เช่น กดปุ่ม  +  จะเข้าสู่ค�ำสั่ง Save (กดปุ่ม  พร้อมกบัปุ่ม ) หรอืการกดปุ่ม Function Keys ก็
สามารถเรยีกใช้ค�ำสั่งได้อกีด้วย

NOTE การเรียกค�ำสั่งด้วยการพิมพ ์(Typing)

นอกจากนั้นเรายงัสามารถก�ำหนดค่าตวัเลข และเลอืกค�ำสั่งย่อยได้จากตรงส่วนนี้ โดยถ้าเป็น Dynamic Input 

ให้กดปุ่ม Down  แล้วคลกิเลอืกค�ำสั่งย่อย ถ้าเป็น Command Line ให้คลกิเลอืกค�ำสั่งย่อยใน Command Line ได้เลย 

และเราสามารถเรยีกใช้ค�ำสั่งที่ใช้งานผ่านมาแล้วจาก Dynamic Input ด้วยการกดปุ่ม Down  หรอืคลกิปุ่ม Recent 

Command จาก Command Line ได้เช่นกนั

พิมพ์ชื่อค�ำสั่งได้ทั้งที่ Command Line หรือ Dynamic Input

เลือกค�ำสั่งย่อย ก�ำหนดค่า หรือเลือกค�ำสั่งที่เคยใช้งานได้ทั้งที่ Command Line หรือ Dynamic Input
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การท�ำงานของเมาส์และคีย์บอร์ด
การเรยีกใช้ค�ำสั่งต่างๆ ใน AutoCAD นั้นจ�ำเป็นต้องอาศยัเมาส์และคยี์บอร์ด โดยการใช้งานของเมาส์ด้วยการ

คลิกปุ่มนั้น จะให้ผลลัพธ์ที่แตกต่างกันออกไปตามวิธีการคลิกในแต่ละแบบ ส่วนการกดปุ่มฟังก์ชันบนคีย์บอร์ด

จะเป็นการใช้คีย์ลัด เพื่อเรียกใช้ค�ำสั่งได้อย่างรวดเร็วยิ่งขึ้น ซึ่งมีรายละเอียดต่างๆ ของการใช้งานทั้งเมาส์และ

คยี์บอร์ดดงันี้

การใช้เมาส์ใน AutoCAD
เมาส์เป็นอุปกรณ์ส�ำคญัที่ใช้ในการเขียนแบบด้วย AutoCAD เพื่อเข้าสู่ค�ำสั่ง โดยเฉพาะอย่างยิ่งการเรียกใช้

ค�ำสั่งด้วยการคลกิที่ไอคอน การก�ำหนดต�ำแหน่งในการเขยีนแบบ หรือการเลือกชิ้นงานในการแก้ไข ซึ่งแต่ละปุ่ม

บนเมาส์มหีน้าที่และรายละเอยีดต่างๆ ดงันี้

A 	 คลิกซ้าย (Left Click) เป็นปุ่มที่อยู่ด้านซ้าย ใช้คลกิเพื่อเลอืกค�ำสั่ง หรอืคลกิเพื่อเลอืกต�ำแหน่งบนพื้นที่ใน

การเขยีนแบบ นอกจากนั้นยงัสามารถใช้การดบัเบลิคลกิได้ด้วย (คลกิ 2 ครั้งตดิกนั) ถ้าดบัเบลิคลกิที่ชิ้นงาน

ไหน จะเข้าสู่ Properties Palette ของชิ้นงานนั้นๆ เพื่อแสดงคณุสมบตัขิองชิ้นงาน และสามารถปรบัเปลี่ยน

คณุสมบตัขิองชิ้นงานได้จากตรงส่วนนี้ด้วย

คลิกเพื่อก�ำหนดจุดเริ่มต้นในการเขียนรูปทรง หรือดับเบิลคลิกที่ชิ้นงาน เพื่อแสดงคุณสมบัติของชิ้นงาน

A BC
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นอกจากนั้นยงัใช้ในการคลกิลากเมาส์กบัแดรกเมาส์ (คลกิค้างแล้วลากเมาส์) โดยการคลกิซ้ายแล้วลากเมาส์

ใช้ส�ำหรบัก�ำหนดขนาดของชิ้นงาน หรอืสร้างกรอบครอบคลมุชิ้นงานใช้ส�ำหรบัเลอืกชิ้นงาน ซึ่งการคลกิลากเมาส์

สร้างกรอบชิ้นงานไปทางด้านซ้าย (สีเขียว) ชิ้นงานจะถูกเลือกโดยไม่ต้องครอบชิ้นงานทั้งหมด ถ้าคลิกลากเมาส์

สร้างกรอบชิ้นงานไปทางด้านขวา (สนี�้ำเงนิ) ต้องครอบชิ้นงานทั้งหมดจงึจะถูกเลอืก ส่วนการแดรกเมาส์นั้นจะให้

ผลที่แตกต่างกนั 

คลิกจุดเริ่มต้น แล้วลากเมาส์ก�ำหนดขนาด หรือคลิกลากเมาส์สร้างกรอบครอบคลุมชิ้นงาน

คลิกลากเมาส์ไปทางซ้าย กรอบพื้นที่จะเป็นสีเขียว หรือคลิกลากเมาส์ไปทางขวา พื้นที่จะเป็นสีน�้ำเงิน

การแดรกเมาส์กรอบครอบคลุมชิ้นงานจะมีรูปทรงอิสระ แต่คุณสมบัติเหมือนกับการคลิกลากเมาส์
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B 	 คลิกขวา (Right Click) เป็นปุ่มที่อยู่ด้านขวา ใช้คลิกในขณะที่มีการใช้ค�ำสั่งใดค�ำสั่งหนึ่ง เพื่อยอมรับค่า

หรอืจบค�ำสั่ง โดยคลกิขวาแล้วเลอืกค�ำสั่ง Enter และยงัใช้ในการเข้าสู่เมนูค�ำสั่งย่อย เพื่อเลอืกค�ำสั่งอื่นๆ ที่

เกี่ยวข้อง

C 	 ล้อหมุน (Scroll Wheel) เป็นปุ่มล้อหมนุที่อยู่ตรงกลาง สามารถหมนุหรอืคลกิได้ ใช้ในการย่อขยายและ

เลื่อนมมุมองภาพ เหมอืนกบัการใช้ค�ำสั่ง Zoom และ Pan โดยการหมนุขึ้นหรอืลง (Scroll) เพื่อขยายหรอืย่อ

มมุมองภาพ (Zoom Realtime) และแดรกเมาส์เพื่อเลื่อนมมุมองของภาพ (Pan)

หมุน Scroll Wheel ขึ้นเพื่อขยายมุมมองภาพ หรือหมุนลงเพื่อย่อมุมมองภาพ

ใช้ Scroll Wheel แดรกเมาส์เพื่อเลื่อนมุมมองภาพ โดยจะไปตามการแดรกเมาส์

คลิกขวาแล้วเลือกค�ำสั่ง Enter หรือค�ำสั่งย่อยอื่นๆ 
ถ้าหากคลิกขวาที่พื้นที่ในการเขียนแบบ (Drawing Window) จะมีค�ำสั่งอื่นๆ ให้เลือกเช่นกัน
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A B D F H J LC E G I K

การใช ้Function Keys บนคีย์บอร์ด
คยี์บอร์ด นอกจากจะใช้ส�ำหรบัการพมิพ์ค�ำสั่งหรอืก�ำหนดค่าตวัเลขต่างๆ ที่ Command Line หรอื Dynamic 

Input แล้ว ยงัสามารถใช้ Function Keys เพื่อเรยีกค�ำสั่งต่างๆ ที่ช่วยในการเขยีนแบบได้อกีด้วย ท�ำให้การท�ำงาน

สะดวกรวดเรว็ยิ่งขึ้น ซึ่ง Function Keys มรีายละเอยีดต่างๆ ดงันี้

A 	 F1 (Help) ใช้ส�ำหรับการให้ค�ำแนะน�ำค�ำสั่งหรือเครื่องมือที่เราเลือกใช้อยู่ โดยถ้าเราเลือกใช้ค�ำสั่งใด แล้ว 

กดปุ่ม  จะแสดงหน้าต่าง Help ในหวัข้อของค�ำสั่งหรอืเครื่องมอืนั้นๆ เพื่อให้ค�ำแนะน�ำการใช้งาน

คลิกเลือกค�ำสั่ง แล้วกดปุ่ม  เพื่อแสดงข้อมูลค�ำแนะน�ำการใช้ค�ำสั่งที่ได้เลือก

B 	 F2 (Expanded History) ใช้ส�ำหรบัดูข้อมูลในการใช้ค�ำสั่งที่ผ่านมาที่เป็นค�ำสั่งย้อนหลงัใน Command Line

กดปุ่ม  เพื่อแสดงการใช้ค�ำสั่งย้อนหลัง เหมือนกับการคลิกปุ่ม Command History

Book 1.indb   21 1/13/22   11:34 AM



Professional Guide AutoCAD 2022

22

C 	 F3 (Object Snap) ใช้ส�ำหรบัควบคมุการเปิดปิดการใช้ค�ำสั่ง Object Snap ซึ่งเป็นค�ำสั่งช่วยในการเขยีนแบบ 

ส�ำหรบัการเข้าหาต�ำแหน่งต่างๆ ของชิ้นงาน เช่น จดุปลาย จดุตดั หรอืจดุสมัผสั

D 	 F4 (3D Object Snap) ใช้ส�ำหรบัควบคมุการเปิดปิดการใช้ค�ำสั่ง 3D Object Snap ซึ่งเหมอืนกบัค�ำสั่ง Object 

Snap แต่เป็น Object Snap ที่ใช้กบังาน 3D

กดปุ่ม  เพื่อเปิดการใช้งาน Object Snap กดปุ่ม  เพื่อเปิดการใช้งาน 3D Object Snap

E 	 F5 (Isoplane) ใช้ส�ำหรบัควบคมุการเปลี่ยนระนาบของการเขยีนภาพฉาย ส�ำหรบัภาพ Isometric และ Oblique 

โดยเป็นการเปลี่ยนระหว่างภาพฉายด้านบน (Top), ด้านหน้า (Front หรอื Right) และด้านข้าง (Side หรอื Left)

กดปุ่ม  เพื่อเปลี่ยนระนาบของการเขียนภาพ ซึ่งเราต้องเปิดการใช้งานของโหมดนี้ด้วยจึงจะใช้งานได้

F 	 F6 (Dynamic UCS) ใช้ส�ำหรบัควบคมุการเปิดปิดการใช้ค�ำสั่ง Dynamic UCS ซึ่งเป็นค�ำสั่งในการจดัต�ำแหน่ง 

UCS อตัโนมตับินพื้นผวิเรยีบของชิ้นงานรูปทรง 3D

กดปุ่ม  เพื่อเปิดการใช้งาน Dynamic UCS ให้สามารถสร้างชิ้นงานบนพื้นผิวของรูปทรง 3D ได้ทันที
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G 	 F7 (Grid) ใช้ส�ำหรบัควบคมุการเปิดปิดการใช้งานของ Grid ซึ่งเป็นค�ำสั่งช่วยในการเขยีนแบบที่แสดงเป็นเส้น

ตารางบนพื้นที่การท�ำงานที่เราจะใช้ในการเขยีนแบบ

กดปุ่ม  เพื่อเปิดการใช้งาน Grid ให้แสดงเส้นตารางบนพื้นที่การเขียนแบบ (Drawing Window)

H 	 F8 (Ortho) ใช้ส�ำหรบัควบคมุการเปิดปิดการใช้งานของ Ortho ซึ่งเป็นค�ำสั่งช่วยในการเขยีนแบบให้ Cross 

Hair เคลื่อนที่เป็นแนวตรงหรอืตั้งฉาก ช่วยในการเขยีนเส้นหรอืลาก Cross Hair ให้ตรง

กดปุ่ม  เพื่อเปิดการใช้งาน Ortho ช่วยให้เขียนเส้นในแนวตรงตั้งฉากได้ง่ายยิ่งขึ้น

I 	 F9 (Snap) ใช้ส�ำหรบัควบคมุการเปิดปิดการใช้งานของ Snap ซึ่งเป็นค�ำสั่งช่วยในการเคลื่อนที่ของ Cross Hair 

ให้ไปตามจดุต่างๆ ของ Grid หรอื Polar โดยสามารถก�ำหนดระยะที่ต้องการให้เคลื่อนที่ได้

กดปุ่ม  เพื่อเปิดการใช้งาน Snap ช่วยให้การเคลื่อนที่ของ Cross Hair ตรงกับจุดเส้นตัดตารางได้ง่ายขึ้น
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J 	 F10 (Polar Tracking) ใช้ส�ำหรบัควบคมุการเปิดปิดการใช้งาน Polar Tracking ซึ่งเป็นค�ำสั่งช่วยในการเขยีนแบบ 

ให้ Cross Hair เคลื่อนที่ในแนวองศาที่ได้เลอืกไว้

กดปุ่ม  เพื่อเปิดการใช้งาน Polar Tracking ช่วยให้เขียนเส้นในทิศทางขององศาที ่ได้เลือกไว้ได้ง่ายขึ้น

K 	 F11 (Object Snap Tracking) ใช้ส�ำหรบัควบคมุการปิดเปิดการใช้งาน Object Snap Tracking ซึ่งเป็นค�ำสั่ง 

ช่วยในการหาต�ำแหน่งในระนาบเดียวกับ Object Snap โดยจะแสดงเส้นแนวตั้งและแนวนอน ซึ่งจะใช้ได ้

ต่อเมื่อได้เปิดใช้ค�ำสั่ง Object Snap

กดปุ่ม  เพื่อเปิดการใช้งาน Object Snap Tracking
ช่วยในการหาต�ำแหน่งในระนาบเดียวกันของ Object Snap ด้วยการแสดงเส้นให้เห็น

L 	 F12 (Dynamic Input) ใช้ส�ำหรับควบคุมการปิดเปิดการใช้งานของ Dynamic Input ซึ่งเป็นส่วนที่ใช้ใน 

การพมิพ์เรยีกใช้ค�ำสั่ง ก�ำหนดค่าตวัเลข หรอืเลอืกค�ำสั่งย่อย

กดปุ่ม  เพื่อเปิดการใช้งาน Dynamic Input ช่วยในการเรียกค�ำสั่ง ก�ำหนดค่าตัวเลข หรือเลือกค�ำสั่งย่อย
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การท�ำงานเกี่ยวกับไฟล์ (File & Edit)
เป็นค�ำสั่งพื้นฐานการใช้งานเกี่ยวกับไฟล์งานและการแก้ไขการท�ำงาน ทั้งการเปิดไฟล์งานเดิม การสร้าง 

ไฟล์งานขึ้นมาใหม่ หรอืย้อนขั้นตอนการท�ำงาน ซึ่งค�ำสั่งเหล่านี้จะอยู่ในเมนู File และเมนู Edit ของ Menu Bar แต่

กส็ามารถเรยีกใช้งานได้จากวธิกีารดงัต่อไปนี้

สร้างไฟล์ใหม่ (New)
การสร้างไฟล์งานใหม่ท�ำได้ทั้งการคลกิค�ำสั่ง New หรอืคลกิแทบ็ Start แล้วคลกิที่ ลูกศร New กท็�ำได้เช่นกนั 

แล้วเลือกไฟล์ Template ที่ต้องการใช้งาน นอกจากนั้นการคลกิปุ่ม New Drawing กส็ร้างไฟล์งานใหม่ได้ แต่ไม่

สามารถเลอืกไฟล์ Template ได้ โดยไฟล์ Template จะเป็นแบบเดมิตามที่เคยได้มกีารเลอืกไว้

คลิกค�ำสั่ง New เลือกแบบงาน (Template) ที่ต้องการ แล้วคลิกปุ่ม Open

คลิกแท็บ Start เลือกไฟล์ Template ที่ต้องการ หรือคลิกปุ่ม New Drawing เพื่อสร้างไฟล์งานใหม่ก็ได้เช่นกัน
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เปิดไฟล์งานเดิม (Open)
การเปิดไฟล์งานเดิมเป็นการเปิดไฟล์งานที่เคยท�ำงานไว้ขึ้นมาใช้งาน วิธีการไม่ต่างกับการสร้างไฟล์งานใหม่

ท�ำได้ทั้งการคลกิค�ำสั่ง Open แล้วเลอืกไฟล์งานที่ต้องการ หรอืคลกิแทบ็ Start แล้วคลกิปุ่ม Open Files กไ็ด้เช่นกนั  

ส่วนถ้าต้องการเปิดไฟล์ที่เคยใช้งานไว้ ในส่วนของ Recent จะมไีฟล์เหล่านั้นให้เราได้เลอืก

Recent เป็นส่วนที่จะแสดงไฟล์ที่มกีารใช้งานล่าสดุของเรา โดยจะแสดงชื่อไฟล์ ภาพชิ้นงาน และวนัเวลาในการใช้งาน
ไฟล์ดงักล่าวไว้อกีด้วย ถ้าต้องการเปิดไฟล์งานเดมิที่เคยได้ท�ำไว้ การคลิกเลอืกไฟล์จาก Recent เป็นอกีวธิกีารเปิดไฟล์
ที่สะดวกรวดเรว็ดเีช่นกนั 

NOTE ไฟล์การใช้งานล่าสุด Recent

คลิกค�ำสั่ง Open เลือกไฟล์ที่ต้องการเปิดใช้งาน แล้วคลิกปุ่ม Open

คลิกแท็บ Start เลือกไฟล์ที่ต้องการเปิดใช้งาน แล้วคลิกปุ่ม Open
หรือคลิกไฟล์ในส่วนของ Recent เพื่อเปิดไฟล์งานที่ต้องการใช้งาน
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บันทึกการท�ำงานหรือบันทึกไฟล์ (Save & Save As)
การบันทึกการท�ำงานหรือบันทึกไฟล์ เป็นการบันทึกไฟล์ขณะท�ำงานด้วยการคลิกค�ำสั่ง Save หรือกดปุ่ม 

 +  ถ้าเป็นการบนัทกึงานครั้งแรก จะต้องเลอืกพื้นที่ในการจดัเกบ็ ตั้งชื่อและเลอืกประเภทของไฟล์ เหมอืนการ

บนัทกึไฟล์เป็นชื่ออื่น (Save As) หลงัจากบนัทกึงานครั้งแรกแล้ว กส็ามารถบนัทกึการท�ำงานครั้งล่าสดุได้ตลอดเวลา

คลิกค�ำสั่ง Save หรือกดปุ่ม  +  เลือกพื้นที่ในการจัดเก็บ ตั้งชื่อและประเภทของไฟล์ แล้วคลิกปุ่ม Save

หากถ้าต้องการบนัทกึไฟล์ที่ใช้งานอยู่ให้เป็นชื่ออื่น หรอือยากเปลี่ยนเป็นไฟล์ประเภทอื่น ให้คลกิค�ำสั่ง Save 

As หรอืกดปุ่ม  +  +  แล้วตั้งชื่อไฟล์และประเภทของไฟล์ที่ต้องการ ซึ่งเราสามารถเลอืกประเภทไฟล์

ที่รองรบักบัเวอร์ชนัก่อนๆ ได้ จงึเหมาะกบัการบนัทกึเปลี่ยนไฟล์เพื่อน�ำไปใช้กบั AutoCAD ในรุ่นอื่นๆ 

คลิกค�ำสั่ง Save As หรือกดปุ่ม  +  +  เลือกพื้นที่ในการจัดเก็บ
ตั้งชื่อและประเภทของไฟล์ที่รองรับกับเวอร์ชัน แล้วคลิกปุ่ม Save
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ย้อนขั้นตอนในการท�ำงาน (Undo/Redo)
การท�ำงานในทกุขั้นตอนจะถูกบนัทกึจดัเกบ็ไว้ หากเกดิข้อผดิพลาดเราสามารถที่จะย้อนกลบัไปในขั้นตอนที่

ผ่านมาได้ด้วยการคลิกค�ำสั่ง Undo หรอืกดปุ่ม  + Z  การท�ำงานจะถูกย้อนกลบัไป 1 ขั้นตอน แต่ถ้าต้องการ

ย้อนกลับไปมากกว่านั้น ให้คลิกปุ่มลูกศร Undo จะแสดงขั้นตอนการท�ำงานที่ผ่านมา แล้วคลิกเลือกขั้นตอนที่

ต้องการได้เลย 

ถ้าเราได้เลือกย้อนขั้นตอนในการท�ำงานกลับไปแล้ว และการย้อนขั้นตอนกลับมาให้คลิกค�ำสั่ง Redo หรือ 

กดปุ่ม  + Y  การท�ำงานจะถูกย้อนกลบัมา 1 ขั้นตอน แต่ถ้าต้องการย้อนกลบัมามากกว่านั้น ให้คลกิปุ่ม 

ลูกศร Redo จะแสดงขั้นตอนการท�ำงานที่จะกลบัไป แล้วคลกิเลอืกขั้นตอนที่ต้องการได้เลย

คลิกปุ่มลูกศร Undo แล้วเลือกขั้นตอนที่ต้องการจะย้อนกลับไป พื้นที่การเขียนแบบจะแสดงการท�ำงานในขั้นตอนที ่ได้เลือก

คลิกปุ่มลูกศร Redo แล้วเลือกขั้นตอนที่ต้องการจะย้อนกลับมา พื้นที่การเขียนแบบจะแสดงการท�ำงานในขั้นตอนที่ ได้เลือก
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ลองเขียนแบบ 2D และขึ้นรูปทรง 3D แบบง่ายๆ
ก่อนที่จะไปเรยีนรู้การเขยีนแบบ 2D และขึ้นรูปทรง 3D ใน Part ของการเขยีนแบบ 2D และ 3D เรามาลอง

เขยีนรูปทรง 2D และขึ้นชิ้นงานเป็น 3D แบบง่ายๆ กนั โดยท�ำตามขั้นตอนแบบ Step by Step เริ่มต้นจากการเขยีน

เส้นรูปทรง 2D จนไปถงึขึ้นรูปทรงเป็น 3D และใส่พื้นผวิให้กบัชิ้นงาน โดยเมื่อเข้ามาในโปรแกรมให้คลกิที่ Start 

Drawing เพื่อสร้างไฟล์งานขึ้นมาใหม่

Step 
01

1  เมื่อได้ไฟล์งานใหม่แล้ว (Drawing1) ให้คลกิค�ำสั่ง Polyline 2  คลกิจดุเริ่มต้น 3  ลากเมาส์ไปทาง
ขวาเขยีนเส้นตรงยาว 15 หน่วย แล้วคลกิจดุที่สอง 4  ลากเมาส์ลงล่างเขยีนเส้นตรงยาว 10 หน่วย 
แล้วคลกิจดุที่สาม 5  ลากเมาส์ไปทางซ้ายเขยีนเส้นตรงยาว 10 หน่วย แล้วคลกิจดุที่สี่ 6  จากนั้น
คลกิขวาแล้วเลอืกค�ำสั่ง Arc 7  คลกิเลอืกค�ำสั่งย่อย CEnter

Step 
02

1  ลากเมาส์ไปทางซ้ายความยาว 5 หน่วย แล้วคลกิจดุศูนย์กลางของเส้นโค้ง 2  ลากเมาส์ขึ้นไป 
90° องศา แล้วคลกิจดุที่ห้า 3  คลกิ≠≠≠เลอืกค�ำสั่งย่อย CLose เพื่อปิดเส้น 4  เส้นโค้งจะลากกลบัไปจดุ
เริ่มต้น ได้เป็นชิ้นงานรูปทรงปิด

7

3

45

6

2

1

2

3

4

1
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Step 
03

1  คลกิค�ำสั่ง Circle 2  คลกิจดุเริ่มต้น 3  พมิพ์ก�ำหนดค่ารศัมวีงกลมเป็น 1 หน่วย แล้วกดปุ่ม 
 4  กดปุ่ม  แล้วคลกิจดุเริ่มต้น 5  พมิพ์ก�ำหนดค่ารศัมวีงกลมเป็น 3 หน่วย แล้วกดปุ่ม 
 6  จะได้ชิ้นงานรูปทรงปิด 2D

Step 
04

1  เปลี่ยน Workspace เป็นแบบ 3D Modeling 2  คลกิเลอืก SW Isometric เพื่อเปลี่ยนมมุมองภาพ 
3  คลกิค�ำสั่ง Presspull 4  คลกิเลอืกพื้นผวิชิ้นงานรูปทรงปิด 5  พมิพ์ก�ำหนดความสูงของชิ้นงาน
เป็น 3.5 หน่วย แล้วกดปุ่ม 

1

4

5

1

3

3

5

4

2

2

6

เมื่อได้ชิ้นงานรปูทรงปิด 2D แล้ว ต่อไปเราจะท�ำชิ้นงาน 2D ให้เป็นชิ้นงานรปูทรง 3D โดยจะเปลี่ยน Workspace 

ให้เป็นรูปแบบ 3D Modeling เพื่อที่จะใช้การท�ำงานแบบ 3D ในการขึ้นรูปทรงชิ้นงาน
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Step 
05

1  คลกิ Ribbon แทบ็ Solid แล้วคลกิค�ำสั่ง Fillet Edge 2  คลกิเลอืกขอบมมุ แล้วกดปุ่ม Down  คลกิ
เลอืกค�ำสั่งย่อย Radius 3  ก�ำหนดค่ารศัมขีอบมมุเป็น 3 หน่วย แล้วกดปุ่ม  3 ครั้งเพื่อจบค�ำสั่ง 

Step 
06

1  คลกิเลอืก Realistic เพื่อเปลี่ยนการแสดงผลของชิ้นงาน 2  คลกิ Ribbon แทบ็ Home แล้วคลกิ
ค�ำสั่ง Erase 3  คลกิเลอืกเส้นชิ้นงานรูปทรง 2D แล้วกดปุ่ม  เพื่อลบชิ้นงาน 2D

1

3

เราสามารถเปิดดูไฟล์งานที่ท�ำเสรจ็แล้วได้จากไฟล์ 00_2D to 3D เพื่อเข้าไปศกึษาเพิ่มเตมิ ซึ่งจะแบ่งชิ้นงาน 2D และ 
3D ออกเป็น 2 เลเยอร์ด้วยกนั สามารถคลกิเลอืกที่เลเยอร์ 2D หรอื 3D เพื่อดูชิ้นงานได้เลย

NOTE ไฟล์งาน 2D to 3D แบบเสร็จสมบูรณ์

3

2

2

1
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Step 
07

1  คลกิ Ribbon แทบ็ Visualize แล้วคลกิค�ำสั่ง Materials/Textures On เพื่อให้แสดงผลของวสัดุและ
พื้นผวิ 2  คลกิค�ำสั่ง Materials Browser เพื่อเปิดพาเลท Materials Browser ใช้เลอืกวสัดแุละพื้นผวิ 
3  คลกิปุ่ม Adds Material to Document เลอืกพื้นผวิ Rough – Pink ไปเกบ็ไว้ใน Document Materials 
All 4  คลกิเลอืกชิ้นงานรูปทรง 3D 5  คลกิเลอืก Rough – Pink เพื่อใส่พื้นผวิให้กบัชิ้นงานรูปทรง 3D

Step 
08

1  คลกิค�ำสั่ง Materials Browser เพื่อปิดหน้าต่าง Materials Browser 2  จะได้ชิ้นงานรูปทรง 3D 
ผวิขรขุระจากการเริ่มต้นเขยีนเส้นรูปทรง 2D จนไปถงึขึ้นรูปทรงเป็น 3D และใส่พื้นผวิให้กบัชิ้นงาน 

2

5

3

1

2

1

4
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ั่งพื้นฐา

นเบื้องต
้นC H A P T E R01

เมื่อรู ้จักกับความส�ำคัญของการเขียนแบบและ

โปรแกรม AutoCAD แล้ว ก่อนที่จะไปรู้จักวิธีการและค�ำสั่ง

ต่างๆ ที่ใช้ในการเขียนแบบ 2D เรามาท�ำความเขา้ใจหลักใน

การเขยีนแบบ และค�ำสัง่พืน้ฐานเบือ้งต้นกนัก่อน โดยจะบอก

หลกัการ วิธคีดิ หรือเทคนคิง่ายๆ กบัการเขียนแบบ 2D ด้วย 

AutoCAD และค�ำสัง่ทีเ่กีย่วกบัการควบคมุมมุมองภาพ การ

เข้าหาต�ำแหน่งที่แม่นย�ำ การก�ำหนดระยะ ทิศทาง และขนาด

ของชิ้นงานในการเขียนแบบ ซึ่งเป็นค�ำสั่งพื้นฐานเบื้องต้น

ของการเขียนแบบ 2D
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เทคนิคง่ายๆ กับการเขียนแบบ 2D ด้วย AutoCAD
ส�ำหรบัการเริ่มต้นเขยีนแบบของมอืสมคัรเล่นนั้น สิ่งแรกที่ต้องมคีอื ต้องกล้าใช้โปรแกรม อย่ากลวัว่า

จะท�ำไม่ได้ อย่าคิดว่ามันจะยาก เพราะไม่มีใครท�ำอะไรเป็นมาตั้งแต่เกิด ซึ่งแนวคิดและเทคนิคง่ายๆ ที่
อยากแนะน�ำส�ำหรบัผู้ที่คดิจะเริ่มเขยีนแบบ 2D ด้วย AutoCAD นั่นกค็อื

�	ไม่จ�ำเป็นต้องนกึถงึความถูกต้องของการเขยีนแบบอย่างมอือาชพี ลองเขยีนดกู่อนถงึแม้ว่าหลกัการอาจจะ

ไม่ถูกต้อง แต่ผลที่ได้ออกมาเหมอืนกนักถ็อืว่าใช้ได้

�	นึกถึงช่วงเวลาที่เราเรียนเขียนแบบ หรือวาดรูปสมัยเด็กๆ ด้วยดินสอ ยางลบ ปากกา ไม้บรรทัด และ

กระดาษ แล้วเริ่มลงมอืเขยีน เราเขยีนแบบลงในกระดาษอย่างไร การเขยีนแบบด้วย AutoCAD กเ็ป็นอย่างนั้น

�	จะเขยีนลายเส้นแบบไหน กใ็ห้นกึถงึค�ำสั่งที่น่าจะมใีน AutoCAD แล้วหาค�ำสั่งนั้นๆ มาใช้งาน ในที่นี้จ�ำเป็น

จะต้องนกึถงึค�ำสั่งเป็นภาษาองักฤษ เช่น ถ้าต้องการจะเขยีนเส้นตรง กใ็ห้นกึถงึเส้น (ค�ำสั่ง Line) ถ้าต้องการ

จะเขยีนวงกลม กใ็ห้นกึถงึวงกลม (ค�ำสั่ง Circle) ถ้าต้องการจะลบเส้น กน็กึถงึยางลบ (ค�ำสั่ง Erase)

วาดรูปเขียนเส้นลงในกระดาษอย่างไร การเขียนแบบด้วย AutoCAD ก็เป็นอย่างนั้น

�	ทดลองเขียนแบบด้วย AutoCAD อย่างจริงจัง ไม่ใช่ทดลองโดยการจินตนาการเอาเอง อ่านแต่คู่มือแล้ว

เข้าใจว่าตวัเองใช้งานเป็น ถ้าคดิแบบนี้แล้วไม่ลงมอืท�ำเมื่อไรจะเขยีนแบบได้

�	เขยีนแล้วเขยีนอกีจนจ�ำค�ำสั่งและวธิกีารที่ใช้งานบ่อยๆ ได้ การท�ำอะไรซ�้ำๆ บ่อยครั้ง จะท�ำให้เราช�ำนาญขึ้น

�	หมั่นฝึกฝนหรอืศกึษาการใช้ค�ำสั่งอื่นๆ เพิ่มเตมิเพื่อให้ได้ผลงานดขีึ้น และการท�ำงานที่รวดเรว็ยิ่งขึ้น

�	ศกึษาหาความรู้เพิ่มเตมิถงึมาตรฐานในการเขยีนแบบ ถ้าต้องการจะเป็นมอือาชพี

ลองน�ำเทคนคิต่างๆ เหล่านี้ไปใช้ หวงัว่าคงจะเกดิประโยชน์ได้ไม่มากกน็้อย เมื่อเริ่มมคีวามคดิที่อยากจะลอง

เขียนแบบกันแล้ว คราวนี้เราไปท�ำความรู้จักกับค�ำสั่งพื้นฐานเบื้องต้นของการเขียนแบบ 2D ด้วย AutoCAD กัน

ก่อนว่ามอีะไรบ้าง
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B
A

เราสามารถเปิดไฟล์งาน 01_Zoom & Pan.dwg เพื่อทดลองใช้ค�ำสั่ง Zoom และ Pan โดยท�ำตามขั้นตอนที่ได้อธบิายไว้

NOTE เปิดไฟล์งาน 01_Zoom & Pan.dwg ทดลองใช้ค�ำสั่ง Zoom และ Pan

ควบคุมมุมมองภาพ 2D
การควบคมุมมุมองภาพเป็นการเปลี่ยนมมุมอง หรอืการแสดงผลของภาพให้มขีนาดเหมาะสมต่อการ

ท�ำงาน เราสามารถขยายมมุมองภาพให้มองเหน็ในระยะใกล้ๆ และเลื่อนหาต�ำแหน่ง เพื่อให้เหน็รายละเอยีด
และเขยีนแบบได้อย่างถูกต้อง ซึ่งค�ำสั่งที่ใช้ในการควบคมุมมุมองภาพ 2D สามารถเลอืกใช้ได้ทั้งการคลกิ
เมนู View, พมิพ์ค�ำสั่งที่ Command Line หรอื Dynamic Input และใน Navigation Bar ที่ด้านขวามอืของ
พื้นที่ในการเขยีนแบบ หากไม่มใีห้คลกิ Ribbon แทบ็ View แล้วให้คลกิที่ Navigation Bar โดยค�ำสั่งที่ใช้ใน
การควบคมุมมุมองภาพ 2D จะมอียู่ 2 ค�ำสั่งดงันี้ 

เลือกการเรียกใช้กลุ่มค�ำสั่ง Zoom และ Pan ได้ทั้ง 3 แบบตามความถนัดของเราได้เลย

A 	 Zoom | View > Zoom | Z (ZOOM) ย่อหรอืขยายมมุมองภาพในส่วนที่เราต้องการ บนพื้นที่การท�ำงาน 

(Drawing Window) ซึ่งจะมรีปูแบบการย่อหรอืขยายมมุมองภาพให้เลอืกหลายรปูแบบด้วยกนั ทั้ง Zoom Extents, 

Zoom Window, Zoom Previous, Zoom All, Zoom Dynamic, Zoom Scale, Zoom Center, Zoom Object, Zoom 

In และ Zoom Out

B 	 Pan | View > Pan | P (PAN) เลื่อนมมุมองภาพไปยงัต�ำแหน่งที่ต้องการ
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A

1

B

F

J

D

H

C

G

K

E

I

2

1

2

Zoom | View > Zoom | Z (ZOOM)
Zoom เป็นค�ำสั่งที่ใช้ในการย่อหรือขยายมุมมองภาพ ที่มีรูปแบบของการใช้งานอยู่หลายรูปแบบ 

ด้วยกนั โดยคลกิปุ่มลูกศรค�ำสั่ง Zoom ที่ Navigation Bar แล้วเลอืกรูปแบบที่ต้องการ ซึ่งแต่ละรูปแบบมี
ลกัษณะการใช้งานที่แตกต่างกนัดงันี้

A 	 Zoom Extents เป็นการขยายมุมมองภาพให้เห็นชิ้นงานทั้งหมดเต็มพื้นที่การท�ำงาน โดย 1  คลิกเลือก 

ค�ำสั่ง Zoom Extents 2  ชิ้นงานทั้งหมดจะถูกขยายมมุมองภาพเตม็พื้นที่การท�ำงานพอดี

B 	 Zoom Window เป็นการขยายมมุมองภาพตามกรอบหน้าต่างที่ก�ำหนด โดย 1  คลกิเลอืกค�ำสั่ง Zoom 

Window 2  คลกิลากเมาส์สร้างกรอบหน้าต่าง 3  ชิ้นงานจะถูกขยายมมุมองตามกรอบหน้าต่างที่ก�ำหนด
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1

1

2

2

3

C 	 Zoom Previous เป็นการย้อนกลบัไปดูมมุมองภาพก่อนหน้านี้ โดย 1  คลกิเลอืกค�ำสั่ง Zoom Previous  
2  มมุมองภาพจะถูกย้อนกลบัไปเป็นมมุมองภาพเดมิ

D 	 Zoom Realtime เป็นการย่อหรอืขยายมุมมองภาพที่จะเหน็การเปลี่ยนแปลงได้ทกุระยะ โดย 1  คลกิเลอืก

ค�ำสั่ง Zoom Realtime 2  แล้วแดรกเมาส์เลื่อนขึ้นหรอืลง มมุมองภาพจะขยายหรอืย่อตามการแดรกเมาส์
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2

2

3 4

1

1

E 	 Zoom All เป็นการปรบัมมุมองภาพให้เหน็ชิ้นงานและพื้นที่ทั้งหมดของไฟล์ (Limit) โดย 1  คลกิเลอืกค�ำสั่ง 

Zoom All 2  มมุมองภาพจะถูกเปลี่ยนให้เหน็ชิ้นงานและพื้นที่ทั้งหมดของไฟล์ (Limit) 

F 	 Zoom Dynamic เป็นการขยายมมุมองภาพแบบก�ำหนดขอบเขตจากมมุมองภาพรวมทั้งหมด โดย 1  คลกิ

เลอืกค�ำสั่ง Zoom Dynamic จะเหน็พื้นที่การท�ำงานทั้งหมดเหมอืนกบั Zoom All 2  ลากเมาส์ แล้วคลกิให้

กรอบเส้นสขีาวไปทบักบักรอบเส้นสเีขยีว 3  ลากเมาส์ แล้วคลกิปรบัขนาดพื้นที่ในการขยายมมุมอง 4  ลาก

เมาส์ให้กรอบไปยงัจดุที่ต้องการขยายมมุมองภาพ แล้วกดปุ่ม  5  มมุมองภาพจะถูกขยายตามพื้นที่ที่

เราก�ำหนด
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5

2

1

กรอบเส้นสนี�้ำเงนิจะบอกขอบเขตของชิ้นงาน และกรอบเส้นประสเีขยีวบอกขอบเขตของพื้นที่ทั้งหมด (Limit) ส่วนกรอบ
เส้นสขีาวเป็นกรอบพื้นที่ที่ใช้ในการขยายมมุมองภาพ

NOTE กรอบเส้นสีต่างๆ ของการ Zoom Dynamic

3

G 	 Zoom Scale เป็นการปรบัมมุมองภาพตามอตัราส่วนที่ก�ำหนด ซึ่งมมุมองเดมิมคี่าเท่ากบั 1 ถ้าก�ำหนดค่า

มากกว่า 1 จะขยายมมุมองภาพ ถ้าน้อยกว่า 1 จะย่อมมุมองภาพ โดย 1  คลกิเลอืกค�ำสั่ง Zoom Scale 
2  พมิพ์ก�ำหนดค่าเป็น 0.5 แล้วกดปุ่ม  3  มมุมองภาพจะถูกย่อลงตามอตัราส่วนที่ก�ำหนด

Book 1.indb   39 1/13/22   11:34 AM



Professional Guide AutoCAD 2022

40

H 	 Zoom Center เป็นการย่อหรือขยายมุมมองภาพแบบก�ำหนดจดุศูนย์กลางและระยะของการย่อหรอืขยาย 

โดย 1  คลกิเลอืกค�ำสั่ง Zoom Center 2  คลกิจดุศูนย์กลางในการขยาย 3  คลกิจดุเริ่มต้นและจดุสิ้นสดุ 

เพื่อก�ำหนดช่วงระยะของการขยาย 4  มมุมองภาพจะขยายตรงจดุศูนย์กลางที่ก�ำหนด

1

4

1

2

2

I 	 Zoom Object เป็นการขยายมมุมองภาพด้วยการเลอืกชิ้นงานที่ต้องการ โดย 1  คลกิเลอืกค�ำสั่ง Zoom 

Object 2  คลกิชิ้นงานที่ต้องการขยายมมุองภาพ แล้วกดปุ่ม  3  ชิ้นงานนั้นจะถูกขยายมมุมองภาพ

3
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3

2

2

1

1

J 	 Zoom In เป็นการขยายมมุมองภาพให้ใหญ่ขึ้น 1 ระดบั โดย 1  คลกิเลอืกค�ำสั่ง Zoom In 2  มมุมองภาพ

จะถูกขยายขึ้น 1 ระดบั 

K 	 Zoom Out เป็นการย่อมมุมองภาพให้เลก็ลง 1 ระดบั โดย 1  คลกิเลอืกค�ำสั่ง Zoom Out 2  มมุมองภาพ

จะถูกย่อลง 1 ระดบั
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